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Evaluation Board for the ADAS3023 16-Bit, 8-Channel,  

Simultaneous Sampling Data Acquisition System 
 

FEATURES 
Full-featured evaluation board for the ADAS3023 
Versatile analog signal conditioning circuitry 
On-board reference, clock oscillator, and buffers 
Converter evaluation and development board (EVAL-CED1Z) 

compatible  
PC software for control and data analysis (time and 

frequency domain) 

KIT CONTENTS 
EVAL-ADAS3023EDZ evaluation board 

ADDITIONAL EQUIPMENT NEEDED 
EVAL-CED1Z board  
Precision signal source  
World-compatible 7 V dc supply (enclosed with EVAL-CED1Z) 
USB cable  

EVALUATION BOARD DESCRIPTION 
The EVAL-ADAS3023EDZ is an evaluation board for the 
ADAS3023 16-bit data acquisition system (DAS). This device 
integrates an 8-channel low leakage track and hold, a high 
impedance programmable gain instrumentation amplifier (PGIA) 
stage with high common-mode rejection, a precision 16-bit 
successive approximation (no latency) analog-to-digital 

converter, and precision 4.096 V reference. It is capable of 
converting two channels simultaneously up to 500,000 samples per 
second (500 kSPS) throughput.  

The evaluation board is designed to demonstrate the perform-
ance of the ADAS3023 and to provide an easy-to-understand 
interface for a variety of system applications. A full description 
of this product is available in the product data sheet and should 
be consulted when utilizing this evaluation board.  

The evaluation board is intended to be used with the Analog 
Devices, Inc., converter evaluation and development (CED) 
board, EVAL-CED1Z, a USB-based capture board connected  
to P4, the 96-pin interface.  

On-board components include a high precision, buffered band 
gap 4.096 V reference (ADR434), a reference buffer (AD8032),  
passive signal conditioning circuitry, and an FPGA for 
deserializing the serial conversion results and configuring  
the ADAS3023 via a 4-wire serial interface.   

The P3 connector allows users to test their own interface with 
or without the optional Altera FPGA, U6 (programmed using 
the P2 and passive serial EEPROM, U5).  

 
Figure 1. EVAL-ADAS3023EDZ Evaluation Board 
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EVALUATION BOARD HARDWARE 
OVERVIEW 
The EVAL-ADAS3023EDZ evaluation board is designed to 
offer simple evaluation of this integrated device. From a block 
diagram perspective, the board uses a set of analog input test 
points (or an IDC header), some passive footprints for RC 
filtering and external reference, the ADAS3023 device, a serial 
interface to the on-board FPGA, and power that can be 
supplied locally or via EVAL-CED1Z or externally. Note that 
the ADAS3023 device also has an on-chip reference; however, 
external circuitry is provided for those who need to test other 
suitable options.   

The small prototyping area can be useful for building additional 
circuitry, if desired. Each block has a specific function as 
defined in the following sections.  

DEVICE DESCRIPTION 
Manufactured using the Analog Devices patented high voltage 
iCMOS® process, the ADAS3023 is a complete data acquisition 
system (DAS) on a single chip that is capable of converting two 
channels simultaneously up to 500 kSPS. This part allows the 
differential voltage range up to ±20.48 V when using ±15 V 
supplies. The ADAS3023 can resolve the full-scale differential 
voltages of ±2.56 V, ±5.12 V, ±10.24 V, and ±20.48 V, and it can 
be configured to sample two, four, six, or eight channels 
simultaneously.  

The key difference between the ADAS3022 and ADAS3023  
is that the ADAS3023 does not offer the AUX± channels and 
temperature sensor (using the CFG register) In addition, the 
BUSY/SDO2 (Pin 19) functionality of the ADAS3023 is 
different.   

The ADAS3022/ADAS3023 devices become pin compatible  
and can be exchanged on the same footprint if the no connect 
(NC) pins (Pin 14/Pin 29/Pin 30 on the ADAS3022) and AUX± 
(Pin 5 and Pin 40 on the ADAS3022) are tied to AGND, and if 
the SDO2 (using the CFG register) of the ADAS3023 is not 
enabled, so that the user can actually work with either one of 
these options using the same evaluation board. Leaving these 
pins floating is not recommended. Note that the differential 
paired mode does not exist in the ADAS3023 and, therefore, its 
2/4/6/8 channels are always referenced to COM.  

The ADAS3023 is an ideal replacement for a typical 16-bit,  
simultaneous sampling precision data acquisition system that 
simplifies the design challenges by eliminating signal buffering, 
level shifting, amplification/attenuation, common-mode 
rejection, settling time, or any of the other analog signal 
conditioning challenges while allowing smaller form factor, 
faster time to market, and lower costs. 

Data communication to and from the ADAS3023 occurs 
asynchronously without any pipeline delay using a common 
4-wire serial interface compatible with SPI, FPGA, and DSP.  

A rising edge on CNV samples the differential analog inputs of 
a channel or channel pair. The ADAS3023 configuration register 
allows the user to configure the number of enabled channels, the 
differential input voltage range, and the interface mode using the 
evaluation board and software as detailed in this user guide. 
Complete specifications for the ADAS3023 are provided in the 
product data sheet and should be consulted in conjunction with 
this user guide when using the evaluation board. Full details on 
the EVAL-CED1Z are available on the Analog Devices website. 

Table 1. Typical Input Range Selection  
Single-Ended Signals1 Input Range, VIN (V) 
0 V to 1 V ±1.28 V 
0 V to 2.5 V ±2.56 V 
0 V to 5 V ±5.12 V 
0 V to 10 V ±10.24 V 
1 See the ADAS3023 data sheet for more information 

JUMPERS, SOLDER PADS, AND TEST POINTS 
Numerous solder pads and test points are provided on the 
evaluation board and are detailed fully in Table 4, Table 5,  
and Table 6. Note the nomenclature for this evaluation board 
for a signal that is also connected to an IDC connector would 
be signal_I. The two 3-pin user selectable jumpers are used for  
the ADCs reference selection and are fully described in the 
Reference section.  

ANALOG INTERFACE 
The analog interface is provided with test points for each of the 
analog inputs IN[7:0] and COM (that is, IN0_I is common to 
both the test point and to P1). The passive device footprints  
can be used for filtering, if desired. A simple RC filter made up 
of 22 Ω and 2700 pF NPO capacitors is provided. Note that  
the use of stable dielectric capacitors, such as NPO or COG, is 
required in the analog signal path to preserve the ADAS3023 
distortion. Using X5R or other capacitors in the analog signal 
path greatly reduces the performance of the system. Also, note 
that many bench top arbitrary waveform generators (AWGs) 
use 12-bit or 14-bit digital-to-analog converter outputs such 
that the 16-bit ADAS3023 devices digitize this directly resulting 
in erroneous looking data. If such an AWG is used, a high-order 
band-pass filter should be used to filter the unwanted noise 
from these sources.  

The P31 center pin is connected to the ADAS3023 COM input, 
which can be routed to P1 or GND using P31. For channel ‐to‐ 

COM configuration, set the jumper across Pin 1 and Pin 2 to 
route to P1. For channel pairs configuration, set the jumper 
across Pin 2 to Pin 3 to route to GND. This is useful for single-
ended applications. 
For dynamic performance, an FFT test can be done by applying 
a very low distortion ac source, such as an Audio Precision 
System 2702. This source can be set for balanced or unbalanced, 
and can be floated or grounded depending on the user’s choice. 
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FPGA 
The on-board FPGA performs a number of digital functions, 
one of them being the sample rate conversion controlled  
using the software. Another function is deserializing the  
serial conversion results as the CED data capture board uses  
a 16-bit parallel interface. If desired, the deserialized data can  
be monitored on the 96-pin edge connecter P1, BD[15:0].  
The CED uses a buffered busy signal, BBUSY, as the general 
interrupt for the data transfer to the CED board.  

The FPGA also provides the necessary ADAS3023 asyn-
chronous control signals for RESET and power down (PD). 

The signals from the FPGA to the ADAS3023 can be bypassed 
by modifying the default solder pad connections. As shown in 
Figure 2, each digital signal on the ADAS3023 is connected to 
the larger (top) pad of the three. The default configuration is 
the small pad and larger pad (no text) which connects the 
FPGA to the ADAS3023 (CNV, BUSY, and SDO signals 
shown). The labeled pads, CNV_I, BUSY_I, SDO_I, and so on, 
are the signals that are routed to P3. To use P3 instead of the 
FPGA, unsolder the default connections and resolder from the 
large pad to the xxx_I pads. The FPGA will remain powered; 
however, if all the signals are bypassed in this fashion, it will not 
have any influence on the ADAS3023. 

 
Figure 2. Digital Interface Solder Pads—Partial View 

Serial Interface 

The 4-wire serial interface consisting of CS, DIN, SCK, and 
SDO is present on the digital interface test points and is 
controlled by the FPGA. The FPGA can be bypassed by using 
the solder pads.  

REFERENCE 
The ADAS3023 has an internal 4.096 V reference, along with an 
internal buffer, useful for using an external reference or one can 
use an external 4.096 V reference directly, such as the ADR434 
provided on the evaluation board. The evaluation board can be 
configured to use any of these references. Two jumpers (P5  
and P7) are used for setting the reference in conjunction with 
software control. 

External Reference–Factory Configuration 

The evaluation board includes the ADR434, A1, which is a 
4.096 V precision voltage reference. This reference can drive  
the ADC REF1 or REF2 (REFx) pin directly or it can also be 

buffered with U20, the AD8032; both of these are set to the 
factory default setting.  

Table 2. Factory Reference Jumper Configuration 

Jumper Setting 

P5 REFIN to GND1 

P9 REF to BUF (U20) 
1 The connection is made through R102 = 10 k to GND. 

To use another reference source, there are two methods: 

• For an external unbuffered reference, remove the P9 
jumper and connect a source to the REF test point. 

• Since the ADR434 is a standard 8-lead SOIC, it can also  
be removed and replaced with the user’s reference. In this 
case, the user reference and the U20 AD8032 buffer can  
be used as a reference source. 

Internal 4.096 V Reference 

The ADC has an internal 4.096 V precision reference and  
can be used on most applications. When enabled, 4.096 V will 
be present on the ADAS3023 REFx pin and test point, REF.  
In addition, a voltage will also be present on the ADAS3023 
REFIN pin and test point, REFIN. The voltage present on 
REFIN can be used for other purposes, such as to provide the 
bias voltage; however, it would need a suitable buffer as the 
output impedance of the REFIN is on the order of a few kilo 
ohms and loading this voltage down will degrade the internal 
reference’s performance. 

Table 3. Internal Reference Jumper Configuration 

Jumper Setting 

P5 Open 

P9 Open 

Note that the ADAS3023 configuration register needs to be 
updated either using the included software or by writing the 
appropriate bits to enable the internal reference. 

Internal Reference Buffer 

The internal reference buffer is useful when using an external 
2.5 V reference. When using the internal reference buffer, 
applying 2.5 V to REFIN, which is directly connected to the 
ADC’s REFIN pin, produces 4.096 V at the ADCs REFx pin  
and REF test point. 

POWER SUPPLIES AND GROUNDING 
The on-board ADP3334 low dropout regulators are provided 
for 2.5 V, 3.3 V, and 5 V and also for the FPGA I/O supply 
which is user configurable and set to 3.3 V by default. The 
FPGA core is supplied by a pair of ADP1715 devices set for  
1.2 V. Additional power is supplies via the CED board for an 
alternative +5 V analog and digital 3.3 V/5 V digital through P4.  
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The ADAS3023 requires ±15 V supplies for VDDH and VSSH. 
These must be supplied by the user using a standard lab supply 
ensuring that the return paths are at the same potential. Refer to 
CN-0201 for the complete information on generating these  
±15 V supplies from a +5 V single supply. The differential input 
common-mode voltage (VCM) range changes according to the 
maximum input range selected and the high voltage power 
supplies (VDDH and VSSH). In other words, the specified 
operating input voltage of any input pin requires 2.5 V of 
headroom from the VDDH and VSSH supplies. 

The evaluation board ground plane consists of a solid plane  
on one PCB layer shared on another layer with the power plane. 
To attain high-resolution performance, the board was designed 
to ensure that all digital ground return paths do not cross the 
analog ground return paths, that is, all analog on one side and 
digital on the other.   

EVALUATION BOARD SCHEMATICS/PCB LAYOUT 
The evaluation board is a 6-layer board carefully laid out and 
tested to demonstrate the specific high accuracy performance  
of the ADAS3023 devices. The Evaluation Board Schematics 
and Artwork section of this user guide shows the schematics of 
the evaluation board. 

BASIC HARDWARE SETUP 
The ADAS3023 evaluation board connects to the EVAL-CED1Z 
converter evaluation and demonstration board. The EVAL-
CED1Z board is the controller board, which is the communi-
cation link between the PC and the main evaluation board.  

Figure 3 shows a photograph of the connections made between 
the ADAS3023 daughter board and the EVAL-CED1Z board.  

1. Before connecting power, ensure that the EVAL-
ADAS3023EDZ and the EVAL-CED1Z boards are 
connected firmly together.  

2. Connect the power supplies on the EVAL-ADAS3023EDZ 
board. The EVAL-ADAS3023EDZ requires external power 
supplies of ±15 V. Connect them from a bench top power 
supply.  

3. Connect the EVAL-CED1Z board to the PC via the USB 
cable enclosed in the EVAL-CED1Z kit. If using a 
Windows® XP platform, you may need to search for the 
EVAL-CED1Z drivers. Choose to automatically search for 
the drivers for the EVAL-CED1Z board if prompted by the 
operating system. 

4. Proceed to the Software Installation section to install the 
software. Note that the EVAL-CED1Z board must not  
be connected to the PC’s USB port until the software is 
installed. The 7 V dc supply can be connected, however,  
to check that the board has power (green LED lit).  

 

 
Figure 3. Hardware Configuration—Setting Up the EVAL-ADAS3023EDZ 
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JUMPERS AND TEST POINTS 
Three-pin jumpers are used to configure the ADC reference. Refer to the Reference section for further details and settings. 

Table 4. Pin Jumper Descriptions 
Jumper Default  Function  
P5 REFIN to 

GND 
REFIN Select. Buffered reference input selection. Use in conjunction with P7. 
Note that the ADAS3023 REFx pin and any other circuit traces/test points will produce 4.096 V when using the 
buffered reference configuration; P7 must be left in the open position. 

  REFIN to A2: Uses the on-board ADR381, A2 (2.5 V) reference. The ADAS3023 must use the buffered reference 
configuration. 

  REFIN to GND: Disables the ADAS3023 internal reference. The ADAS3023 must use the full external reference 
configuration.   

  Open: For use either when using the ADAS3023 on-chip reference or when applying an external 2.5 V source. When 
using the on chip reference, a voltage is present on Pin 2 and any other circuit traces/test points. When using an 
external source, the ADAS3023 must use the buffered reference configuration.    

P7 REF to 
BUF 

REF Select. External 4.096 V reference input selection. Use in conjunction with P5. Note that the ADAS3023 REFIN 
pin and any other circuit traces/test points produce 2.5 V when using the internal or external reference 
configuration and P5 must be left in the open position. 

  REF to A1: Uses the on-board ADR434, A1 (4.096 V), reference. The ADAS3023 must use the external reference 
configuration. 

  REF to BUF: Uses the on-board ADR434 followed by the AD8032, U20 unity gain buffer. This allows some adjustment 
to the reference voltage by use of some resistors around the AD8032. The ADAS3023 must use the external 
reference configuration. 

  Open: For use when using the ADAS3023 on-chip reference or an externally applied source connected directly to 
Pin 2 or the REF test point. 

P31 COM to 
PIN 1 

COM Input Select. Center pin connected to ADAS3023 COM pin. Center pin to PIN1 routes COM to P1. Center to 
PIN3 routes COM to GND. 

Solder pads jumpers are factory configured and can be changed by the user.   

Table 5. Analog and Digital Solder Pads Descriptions 
Jumper Name Default  Function  
P9 SDO 1 to 3 SDO Interface Select. Pad 1 to Pad 3 for FPGA; Pad 2 to Pad 3 for P3 to P34. 
P16 DIN 1 to 3 DIN Interface Select. Pad 1 to Pad 3 for FPGA; Pad 2 to Pad 3 for P3 to P35. 
P17 CNV 1 to 3 CNV Interface Select. Pad 1 to Pad 3 for FPGA; Pad 2 to Pad 3 for P3 to P36. 
P18 SCK 1 to 3 SCK Interface Select. Pad 1 to Pad 3 for FPGA; Pad 2 to Pad 3 for P3 to P33. 
P19 BUSY 1 to 3 BUSY Interface Select. Pad 1 to Pad 3 for FPGA; Pad 2 to Pad 3 for P3 to P37. 
P27 RESET 1 to 3 RESET Interface Select. Pad 1 to Pad 3 for FPGA; Pad 2 to Pad 3 for P3 to P38. 
P28 PD 1 to 3 PD Interface Select. Pad 1 to Pad 3 for FPGA; Pad 2 to Pad 3 for P3 to P39. 
P29 CS 1 to 3 CS Interface Select. Pad 1 to Pad 3 for FPGA; Pad 2 to Pad 3 for P3 to P40. 

P25 DSPCLK Soldered CED Clock Source. 
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Table 6. Power Supply Solder Pads 
Jumper Name Default Function  
P6 VDDH Soldered VDDH Supply.  
P13 VSSH Soldered VSSH Supply. 
P8 AVDD +5VA AVDD Supply. Selection of +5 V A, analog supply from the CED board or +5 V from U3.  
P10 – Soldered VIO Supply. This solder pad can be used to power the FPGA VIO and ADAS3023 VIO together.  
P11 – Soldered FPGA VIO Supply. Supplied from U8, 3.3 V, dedicated digital supply.   
P12 VIO Open VIO Supply. Selection of 2.5 V (2V5), 3.3 V (3V3), or DVDD (5V). Note that the ADAS3023 digital outputs are set to 

this level and are directly wired to the FPGA, U6, which is 3.3 V max. When using the 5 V setting, the ADAS3023 
outputs, SDO and BUSY must be resistively divided using the 0603 pads provided on the evaluation board. For 
this reason, P10 is used as the default. 

P14 DVDD +5VD DVDD Supply. Selection of +5 V digital, +5 V D, and +5 V from U3.  
P15 VDRV- −5VA U20 V−/P34 Supply. Selection of −5 V A, analog supply from the CED board or GND.  
P33 VDRV+ +5VA U20 V+/P35 Supply. Selection of +5 V A, analog supply from the CED board or +5 V from U3.  
P34 U4 V+ VDRV+ U4 V+ Supply. Selection of VDRV+ or U2.  
P35 U4 V− VDRV− U4 V− Supply. Selection of VDRV− or GND. 
P22 −15V Soldered −15 V CED Supply.  
P23 −5VA Soldered −5 V A (Analog) CED Supply. 
P24 +5VA Soldered +5 V A (Analog) CED Supply. 
P26 +5VD Soldered +5 V D (Digital) CED Supply. 
P30 +15V Soldered +15 V (Analog) CED Supply. 

Table 7. Test Points (By Signal Type) 
Test Point  Type Description 
IN0_I Analog Input Path for IN0 Input.  
IN1_I Analog Input Path for IN1 Input.  
IN2_I Analog Input Path for IN2 Input.  
IN3_I Analog Input Path for IN3 Input.  
IN4_I Analog Input Path for IN4 Input.  
IN5_I Analog Input Path for IN5 Input.  
IN6_I Analog Input Path for IN6 Input.  
IN7_I Analog Input Path for IN7 Input.  
COM_I Analog Input Path for COM Input.  
REF Analog Input Direct Connection to ADAS3023 REFx Pin. 
REFIN Analog Input Direct Connection to ADAS3023 REFIN Pin. 
CNV Digital Input Direct Connection to ADAS3023 CNV Pin. 
BUSY Digital Output Direct Connection to ADAS3023 BUSY Pin. 
SDO Digital Output Direct Connection to ADAS3023 SDO Pin. 
SCK Digital Input Direct Connection to ADAS3023 SCK Pin. 
PD Digital Input Direct Connection to ADAS3023 PD Pin. 
RESET Digital Input Direct Connection to ADAS3023 RESET Pin. 
DIN Digital Input Direct Connection to ADAS3023 DIN Pin. 
CSB Digital Input Direct Connection to ADAS3023 CS Pin. 

MSCL Digital Output Eval Board Master Clock Form Y3, 100 MHz Oscillator. 
VDDH Power Direct Connection to ADAS3023 VDDH Pin. 
VSSH Power Direct Connection to ADAS3023 VSSH Pin. 
AVDD Power Direct Connection to ADAS3023 AVDD Pin. 
DVDD Power Direct Connection to ADAS3023 DVDD Pin. 
VIO Power Direct Connection to ADAS3023 VIO Pin. 
+5VA Power Connected to P24; CED +5 V A. 
−5VA Power Connected to P23; CED −5 V A. 
+15V Power Connected to P30; CED +5 V A. 
−15V Power Connected to P22; CED −5 V A. 
+5VD Power Connected to P26; CED +5 V D. 
GND(s) Power Connected to Eval Board GND Plane. 
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EVALUATION BOARD SOFTWARE 
SOFTWARE INSTALLATION  
Close major Windows applications prior to installing the software.  

System Requirements  

• Windows® XP (SP2, 32-bit), Windows Vista® (32-bit or  
64-bit), or Windows 7 (32-bit or 64-bit) 

• USB 2.0 (for CED board) 
• Administrator privileges 

Website Download 

The evaluation board software is available for download from 
the evaluation board page on Analog Devices website. Click the 
setup.exe file to run the install. The default location for the 
software is C:\Program Files (x86)\Analog Devices\ 
ADAS3023 Evaluation Software. 

To ensure that the evaluation system is correctly recognized 
when connected to the PC, install the evaluation software 
before connecting the evaluation board and the EVAL-CED1Z 
board to the USB port of the PC. 

There are two portions of the software installation process: 

• ADAS3023 evaluation board software installation 
• EVAL-CED1Z board driver installation 

Figure 4 to Figure 9 show the separate steps to install the 
ADAS3023 evaluation software. Figure 10 to Figure 12 show 
the separate steps to install the EVAL-CED1Z drivers. 

Proceed through all of the installation steps to allow the 
software and drivers to be placed in the appropriate locations.  

Only connect the EVAL-CED1Z board to the PC after the 
software and drivers are installed.  

 
Figure 4. ADAS3023 Evaluation Software Installer 

 
Figure 5. ADAS3023 Evaluation Software Destination Directory 

 
Figure 6. ADAS3023 Evaluation Software License Agreement 

 
Figure 7. ADAS3023 Evaluation Software Start Installation 
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Figure 8. ADAS3023 Evaluation Software, Installation in Progress 

 
Figure 9. ADAS3023 Evaluation Software Installer, Installation Complete 

 
Figure 10. CED Drivers Install Setup Wizard 

 
Figure 11. CED Drivers Install Setup Wizard, Installation in Progress 

 
Figure 12. CED Drivers Install Setup Wizard, Installation Complete 

 
Figure 13. Computer Restart Notice 
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On some PCs, the Found New Hardware Wizard may open. If 
so, follow the same procedure to install it properly. 

The Device Manager can be used to verify that the driver was 
installed successfully. 

 
Figure 14. Device Manager 

Troubleshooting the Installation 

If the driver was not installed successfully, the Device Manager 
displays a question mark for Other devices because Windows 
does not recognize the EVAL-CED1Z board.  

 
Figure 15. Device Manager Troubleshooting 

The USB device can be opened to view the uninstalled 
properties.  

 
Figure 16. USB Device Properties 

This is usually the case if the software and drivers were installed 
by a user without administrator privileges. If so, log on as an 
administrator with full privileges and reinstall the software. 
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POWERING UP THE BOARD 
The evaluation board, as configured from the factory, uses the 
local LDOs for power where necessary. A ±15 V dc lab supply 
must be connected to the board. Test points (yellow and white) 
are provided for these external supplies. 

 
Figure 17. Test Points 

RUNNING THE SOFTWARE WITH THE HARDWARE 
CONNECTED 
The evaluation board includes software for analyzing the 
ADAS3023. The EVAL-CED1Z is required when using the 
software. The software is used to perform the following tests: 

• Histogram tests for determining code transition noise (dc) 
• Time domain analysis 
• Fast Fourier transforms (FFT) for signal-to-noise ratio 

(SNR), SNR and distortion (SINAD), total harmonic 
distortion (THD), and spurious free dynamic range (SFDR) 

This evaluation software is located at <local_drive>:\Program 
Files\Analog Devices\ADAS3023 Evaluation Software. 

To launch the software, click Start>All Programs>Analog 
Devices\ADAS3023 Evaluation Software. You can then apply 
the signal source and capture the data. 

To uninstall the program, click Start>Control Panel>Add or 
Remove Programs>Analog Devices ADAS3023 Evaluation 
Software. 

See Figure 19 to Figure 27 for further details and features of the 
software. 
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SOFTWARE OPERATION 
This section describes the full software operation and all windows 
that appear. When the software is launched, the panel opens 
and the software searches for hardware connected to the PC. 
The user software panel launches, as shown in Figure 18. The 
labels listed in this section correspond to the numbered labels 
in Figure 18. 

File Menu (Label 1) 

The File menu, labeled 1 in Figure 18, provides the following: 

• Save Captured Data saves data to a .csv file. 
• Take Screenshot saves the current screen. 
• Print prints the window to the default printer. 
• Exit quits the application. 

Edit Menu (Label 2) 

The Edit menu, labeled 2 in Figure 18, provides the following: 

• Initialize to Default Values: This option resets the 
software to its initial state. 

Help Menu (Label 3) 

The Help menu, labeled 3 in Figure 18, offers help from the 
following sources: 

• Analog Devices website 
• User Guide 
• Context Help 
• About  

Throughput (Label 4) 

The default throughput (sampling frequency) is 104 kSPS. The 
ADAS3023 is capable of operating a maximum sample 
frequency up to 1000 kSPS.  

Samples (Label 5) 

Select the number of Samples to analyze when running the 
software. This number is limited to 65,536 samples. 

Single Capture (Label 6) and Continuous Capture 
(Label 7) 

Single Capture performs a single capture, whereas Continuous 
Capture performs a continuous capture from the ADC.  

Tabs 

There are four tabs available for displaying the data in different 
formats.  

• Time Domain 
• Histogram 
• Spectrum 
• Summary 

To exit the software, click File>Exit. 
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Figure 18. Setup Screen  

 
Figure 19. Dialog Box for Label 8, Number of Input Channels Settings  
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Figure 20. Dialog Box for Label 9, PGIA Settings 

 
Figure 21. Dialog Box for Label 10, Conversion Mode Settings 

 
Figure 22. Dialog Box for Label 10, SDO2/BUSY Settings 
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Figure 23. Dialog Box for Label 11, Reference Settings 

Start Up 
Refer to the numbered labels in Figure 18. Click the blue 
buttons to reveal the dialog boxes shown in Figure 19 through 
Figure 23. 

To begin evaluating the device, the on-board supplies must be 
enabled. 

• RESET resets the ADAS3023 device to a known state. 
Click RESET twice: once to reset the ADAS3023 and 
again to bring it out of the reset state. Note that the 
CFG is also reset to the default condition.  

• Reference Selection: At this time, it is recommended 
to use the evaluation board’s externally generated 
reference (default). To select the on-chip reference, 
remove the P5 and P7 jumpers and click the button in 
the REF block to display the Reference Settings 
dialog box, then choose REFERENCE ENABLED. 

• PD (0) places the ADAS3023 device in power-down. 
This does not need to take place when starting the 
software. 

• Serial Data Output 2 (SDO2) Option: The ADAS3023 
busy signal is always output on the BUSY/SDO2 pin 
when CS is logic high. If SDO2 is enabled when CS is 
brought low after the EOC, the SDO outputs the data 
from Channel 0, Channel 1, Channel 2, and Channel 3 
and SDO2 outputs the data from Channel 4, Channel 5, 
Channel 6, and Channel 7 after 16 SCK rising edges. 
The conversion result output on this pin synchronizes 
to the SCK falling edges. Click SDO2 DISABLED 
once to display SDO2 ENABLED. 

• Click OK: If the default configuration (number of 
channels, PGIA, reference, and SDO2 settings) is 
acceptable, clicking OK writes to the ADAS3023 
configuration register (CFG). The ADAS3023 device 
is configurable using a 16-bit on-chip register, CFG 
(refer to the ADAS3023 data sheet for more details). 
Note that after changing any of the CFG register 
settings, OK button must be clicked for the new 
setting to take effect.  

Input Channel  

To select the number of input channels to be simultaneously 
sampled, make a selection from the pull-down menu. (see 
Figure 19). 

Programmable Gain 
The most useful and innovative feature of the ADAS3023 is the 
on-chip programmable gain instrumentation amplifier. This 
amplifier has the added flexibility of allowing for inputs ranging 
from ±2.56 V to ±20.48 V. Select the appropriate setting for the 
input voltage span, not including any common-mode signals, 
since they are rejected. Note that the ADAS3023 devices do not 
need the usual level shifting that is common in SAR ADC 
systems. The ADAS3023 devices can accommodate single-
ended unipolar and bipolar input signal types. 

Software Controls 
Within any of the chart panels, these controls are used to 
control the display. 

 Controls the cursor. 

 Controls zooming in and out. 

 Controls panning. 
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TIME DOMAIN TAB 
Figure 24 illustrates the Time Domain tab. The ADAS3023 
output is twos complement output; however, the software 
outputs the results in straight binary. 

 

Note that Label 1 shows the Waveform Analysis that reports 
the amplitude recorded from the captured signal in addition to 
the frequency of the signal tone, and Label 2 shows that Y-axis 
units can be displayed in volts or code (LSB). 

 

 
Figure 24. Time Domain Tab
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HISTOGRAM TAB 
The histogram is most often used for dc testing or ac testing, 
where a user tests the ADC for the code distribution for dc input 
and computes the mean and standard deviation, or transition 
noise, of the converter, and displays the results. Raw data is 
captured and passed to the PC for statistical computations. 
Figure 25 shows the Histogram tab. 

To perform a histogram test,  

1. Select the Histogram tab. 

2. Click Single Capture or Continuous Capture. 

DC Testing  

To test other dc values, apply a source to the selected analog 
inputs IN[7:0]_I via test points or P1. It may be required to 

filter the signal to make the dc source noise compatible with 
that of the ADC. Note that 0805 and 0603 SMT pads are 
provided in each signal path and can be used for filtering the 
source, if necessary. 

AC Testing 

Figure 25 shows the histogram for a 1 kHz sine wave applied to 
the analog inputs IN[7:0]_I via test points or P1 from a quality 
precision signal source, such as Audio Precision. It may be 
required to filter the input signal from the ac source. There is no 
suggested band-pass filter, but consider all choices carefully. 
The Waveform Analysis (Label 1) chart displays the various 
measured histogram values for the ADAS3023.  

 

 

 
Figure 25. Histogram Tab 
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SPECTRUM TAB 
Figure 26 shows the FFT spectrum capture tab. This tab tests 
the traditional ac characteristics of the converter and displays a 
fast Fourier transform (FFT) of the results. As in the histogram 
test, raw data is captured and passed to the PC where the FFT is 
performed, displaying SNR, SINAD, THD, and SFDR.  

To perform an ac test, apply a sinusoidal signal to the evaluation 
board to any pair of the analog inputs IN[7:0]_I, either via test 
points or P1. Very low distortion—a better than 130 dB input 
signal source, such as Audio Precision)—is required to allow 

true evaluation of the part. One possibility is to filter the input 
signal from the ac source. There is no suggested band-pass 
filter, but carefully consider the choices. Figure 26 displays the 
results of the captured data.  

• The top part of the image displays the FFT results 
including SNR, dynamic range, THD, SINAD, and noise 
performance (see Label 1). 

• The lower part of the image displays the fundamental 
frequency and amplitude in addition to the 2nd to 5th 
harmonics (see Label 2). 

 

 
Figure 26. FFT Spectrum with FFT Results (Top) and with Harmonic Content Results (Bottom) 
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SUMMARY TAB 
Figure 27 shows the Summary tab, which summarizes all the 
data capture information and displays it in one panel with a 

synopsis of the information, including key performance 
parameters such as SNR, THD, and SINAD. 

 
 

 
Figure 27. Summary Tab 
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EVALUATION BOARD SCHEMATICS AND ARTWORK 

 
Figure 28. Schematic, DUT, Analog 
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Figure 29. Schematic, Power 
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Figure 30. Schematic, FPGA 
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Figure 31. Schematic, 96-Pin Interface 

 

 
Figure 32. Silkscreen, Top 
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Figure 33. Silkscreen, Bottom 

 

 
Figure 34. Top Layer 1 
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Figure 35. GND Layer 2 

 
Figure 36. Signal Layer 3 
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Figure 37. Signal Layer 4 

 
Figure 38. Power Layer 5 
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Figure 39. Bottom Layer 6 
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PRODUCTS ON THIS EVALUATION BOARD 
BILL OF MATERIALS 

Table 8. 

Qty Reference Description Part Description Value Manufacturer Part Number Instructions 
5 U1 to U3, U8, U12 IC-ADI LDO – Analog Devices ADP3334ACPZ  
2 U10, U11 IC-ADI LDO – Analog Devices ADP1715ARMZ  
1 U20 IC-ADI OPAMP – Analog Devices AD8032ARZ  
1 U4 IC-ADI OPAMP – Analog Devices ADA4841-2YRZ  
1 A1 IC-ADI REFERENCE – Analog Devices ADR434ARMZ  
1 A2 IC-ADI REFERENCE – Analog Devices ADR381ARTZ  
1 U6 IC-CYCLONE II – Altera Devices EP2C5F256C7N  
1 U5 IC SERIAL CONFIG – Altera Devices EPCS4SI8N  
1 Y3 IC CRYSTAL OSC 100 MHZ C-MAC SPXO009437-CFPS-73  
22 C108, C111 to C131 CAP X7R 0402 0.1 µF Murata GRM155R71C104KA88D  
2 C45, C89 CAP X7R 0508 0.1 µF TDK C1220X7R1E104K  
1 C107 CAP NP0 0603 100 pF Phycomp 2238 867 15101 DNI 
6 C17, C20, C24, C25, C36, C88 CAP X8R 0603 0.1 µF Murata GRM188R7E104KA01D  
6 C66 to C68, C79 to C81 CAP X7R 0603    DNI 
11 C38,C65, C70, C71, C72, C73, 

C75, C76, C77, C78, C92 
CAP X7R 0805 0.1 µF Murata GRM21BR71H104KA01L  

7 C8, C29 to C31, C86, C109, C110 CAP C0G 0805 1000 pF Murata GRM2165C2A102JA01D  
11 C43,C44, C46, C47, C49, C50, 

C57, C59, C60, C62, C63 
CAP NPO 0805 2700 pF Murata GRM2165C1H272JA01D   

9 C1, C3, C4, C6, C10, C51, C53, 
C55, C56 

CAP NPO 0805 2700 pF Murata GRM2165C1H272JA01D DNI 

8 C2, C5, C48, C52, C54, C58, 
C61, C64 

CAP NPO 0805 5600 pF Murata GRM2195C1H562JA01D DNI 

15 C7, C9, C18, C19, C21, C22, 
C26 to C28, C32 to C34, C37, 
C85, C87 

CAP X5R 0805 2.2 µF Murata GRM21BR71E225KA73L  

10 C11 to C16, C23, C35, C69, C74 CAP X5R 0805 10 µF Murata GRM21BR61C106KE15L  
2 C84, C90 CAP TANT 10 µF AVX TAJA106K010RNJ  
7 C39 to C42, C91, C93, C94 CAP 0805  Murata – DNI 

1 R94 RES 0402 0 Panasonic-ECG ERJ-2GE0R00X  
4 R32, R72, R73, R103 RES 0603 – Panasonic-ECG – DNI 
6 R2, R71, R125, R126, R136, 

R151 
RES 0603 – Panasonic-ECG – DNI 

6 R30, R31, R59, R137, R137, 
R151 

RES 0603 0 Panasonic-ECG ERJ-3GEY0R00V  

9 R60 to R68 RES 0603, 5% 50 Panasonic-ECG ERJ-3EKF49R9V  
18 R74 to R78, R121, R122, R128, 

R130, R132, R134, R138 to 
R144 

RES 0603, 5% 10 K Panasonic-ECG ERJ-3EKF1002V  

2 R125, R126 RES 0603, 5% 15 K Yageo RC0603FR-0715KL DNI 
2 R13, R55 RES 0603, 1% 140 K Panasonic-ECG   
14 R1, R24 to R26, R29, R80 to 

R82, R85, R86, R95, R97, R99, 
R100 

RES 0805 – Panasonic-ECG – DNI 

25 R7 to R9, R19 to R23, R41 to 
R49, R69, R70, R90 to R93, R96, 
R101 

RES 0805 0 Panasonic-ECG ERJ-6GEY0R00V  

2 R57, R58 RES 0805, 1% 22 Panasonic-ECG  ERJ-6ENF22R0V  
9 R34 to R40, R50, R55 RES 0805, 1% 90.9 Panasonic-ECG ERJ-6ENF90R9V  
1 R27 RES 0805, 1% 365 Panasonic-ECG ERJ-6ENF3652V  

Rev. B | Page 28 of 30 

http://www.analog.com/adp3334?doc=ug-515.pdf
http://www.analog.com/adp1715?doc=ug-515.pdf
http://www.analog.com/ad8032?doc=ug-515.pdf
http://www.analog.com/ada4841?doc=ug-515.pdf
http://www.analog.com/adr434?doc=ug-515.pdf
http://www.analog.com/adr381?doc=ug-515.pdf


EVAL-ADAS3023EDZ User Guide UG-515 
 

Qty Reference Description Part Description Value Manufacturer Part Number Instructions 
9 R33, R52 to R54, R79, R83, R84, 

R87, R88 
RES 0805, 1% 499 Panasonic-ECG ERJ-6ENF4990V  

1 R28 RES 0805, 1% 590 Panasonic-ECG ERJ-6ENF5902V  
2 R89, R145 RES 0805, 1% 604 Panasonic-ECG ERJ-6ENF6040V  
2 R3, R5 RES 0805, 5% 1 K  Panasonic-ECG ERJ-6ENF1001V  
2 R4, R6 RES 0805, 5% 2 K Panasonic-ECG ERJ-6ENF2001V  
6 R10 to R12, R98, R102, R135 RES 0805, 5% 10 K Panasonic-ECG ERJ-6ENF1002V  
1 R16 RES 0805, 1% 64.9 K Panasonic-ECG ERJ-6ENF6492V  
2 R14, R56 RES 0805, 1% 78.7 K Panasonic-ECG ERJ-6ENF7872V  
1 R18 RES 0805, 1% 95.3 K Panasonic-ECG ERJ-6ENF6042V  
1 R17 RES 0805, 1% 107 K Yageo RC0805FR-07300KL  
1 R15 RES 0805, 1% 210 K Panasonic-ECG ERJ-6ENF2103V  
2 CR1,CR2 LED  Green CML CMD28-21VGCTR8T1  
3 P5, P7, P31 CONN-3 PIN MALE Breakaway Samtec TSW-103-08-G-S  
1 P2 CONN-10 PIN MALE RA, shroud 3M 2510-5002UB  
1 P1 CONN-26 PIN MALE Shroud 3M 30326-6002HB  
1 P3 CONN-40 PIN MALE RA, shroud 3M 2540-6002UB  
1 P4 CONN-96 PIN MALE RA, DIN ERNI 533402  
6 GND(S)  Test point, black – Components Corp. TP-104-01-00  
2 +15 V, MCLK Test point, yellow – Components Corp. TP-104-01-04  
4 REF, +5 V A, +5 V D, REFIN Test point, red – Components Corp. TP-104-01-02  
2 −15 V, −5 VA Test point, white – Components Corp. TP-104-01-09  
26 PD, CNV, CSB, DIN, Test point, blue – Components Corp. TP-104-01-06  
 SCK, SDO, VIO,      
 AVDD, BUSY, DVDD,      
 VDDH, VSSH,       
 AUX+I, AUX−I,      
 COM_I, IN0_I−IN7_I,      
 RESET, VDRV+,       
 VDRV−      
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RELATED LINKS 
Resource Description 
ADAS3023 Product Page, ADAS3023, 16-Bit, 8-Channel Simultaneous Sampling Data Acquisition System 
AD8032 Product Page, AD8031/AD8032, Low Power, Low Noise Amplifier  
ADR434 Product Page, ADR434, 4.096 Precision Reference 
ADP1715 Product Page, ADP1715, 500 mA Low Dropout CMOS Linear Regulator with Soft Start 
ADP3334 Product Page, ADP3334, High Accuracy Low IQ, 500 mA, ANYCAP®, Adjustable Low Dropout Regulator  
EVAL-CED1Z Product Page, Converter and Evaluation Development board 
AN-931 Application Note, Understanding PulSAR ADC Support Circuitry 
CN0201 Circuit from the Lab, Complete 5 V, Single-Supply, 8-Channel Multiplexed Data Acquisition System with PGIA for 

Industrial Signal Levels 
 
 
 

 

ESD Caution  
ESD (electrostatic discharge) sensitive device. Charged devices and circuit boards can discharge without detection. Although this product features patented or proprietary protection 
circuitry, damage may occur on devices subjected to high energy ESD. Therefore, proper ESD precautions should be taken to avoid performance degradation or loss of functionality. 

Legal Terms and Conditions 
By using the evaluation board discussed herein (together with any tools, components documentation or support materials, the “Evaluation Board”), you are agreeing to be bound by the terms and conditions 
set forth below (“Agreement”) unless you have purchased the Evaluation Board, in which case the Analog Devices Standard Terms and Conditions of Sale shall govern. Do not use the Evaluation Board until you 
have read and agreed to the Agreement. Your use of the Evaluation Board shall signify your acceptance of the Agreement.  This Agreement is made by and between you (“Customer”) and Analog Devices, Inc. 
(“ADI”), with its principal place of business at One Technology Way, Norwood, MA 02062, USA. Subject to the terms and conditions of the Agreement, ADI hereby grants to Customer a free, limited, personal, 
temporary, non-exclusive, non-sublicensable, non-transferable license to use the Evaluation Board FOR EVALUATION PURPOSES ONLY. Customer understands and agrees that the Evaluation Board is provided 
for the sole and exclusive purpose referenced above, and agrees not to use the Evaluation Board for any other purpose. Furthermore, the license granted is expressly made subject to the following additional 
limitations: Customer shall not (i) rent, lease, display, sell, transfer, assign, sublicense, or distribute the Evaluation Board; and (ii) permit any Third Party to access the Evaluation Board. As used herein, the term 
“Third Party” includes any entity other than ADI, Customer, their employees, affiliates and in-house consultants. The Evaluation Board is NOT sold to Customer; all rights not expressly granted herein, including 
ownership of the Evaluation Board, are reserved by ADI. CONFIDENTIALITY. This Agreement and the Evaluation Board shall all be considered the confidential and proprietary information of ADI. Customer may 
not disclose or transfer any portion of the Evaluation Board to any other party for any reason. Upon discontinuation of use of the Evaluation Board or termination of this Agreement, Customer agrees to 
promptly return the Evaluation Board to ADI. ADDITIONAL RESTRICTIONS. Customer may not disassemble, decompile or reverse engineer chips on the Evaluation Board. Customer shall inform ADI of any 
occurred damages or any modifications or alterations it makes to the Evaluation Board, including but not limited to soldering or any other activity that affects the material content of the Evaluation Board. 
Modifications to the Evaluation Board must comply with applicable law, including but not limited to the RoHS Directive. TERMINATION. ADI may terminate this Agreement at any time upon giving written notice 
to Customer. Customer agrees to return to ADI the Evaluation Board at that time. LIMITATION OF LIABILITY. THE EVALUATION BOARD PROVIDED HEREUNDER IS PROVIDED “AS IS” AND ADI MAKES NO 
WARRANTIES OR REPRESENTATIONS OF ANY KIND WITH RESPECT TO IT. ADI SPECIFICALLY DISCLAIMS ANY REPRESENTATIONS, ENDORSEMENTS, GUARANTEES, OR WARRANTIES, EXPRESS OR IMPLIED, RELATED 
TO THE EVALUATION BOARD INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY OF MERCHANTABILITY, TITLE, FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF INTELLECTUAL 
PROPERTY RIGHTS. IN NO EVENT WILL ADI AND ITS LICENSORS BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES RESULTING FROM CUSTOMER’S POSSESSION OR USE OF 
THE EVALUATION BOARD, INCLUDING BUT NOT LIMITED TO LOST PROFITS, DELAY COSTS, LABOR COSTS OR LOSS OF GOODWILL. ADI’S TOTAL LIABILITY FROM ANY AND ALL CAUSES SHALL BE LIMITED TO THE 
AMOUNT OF ONE HUNDRED US DOLLARS ($100.00). EXPORT. Customer agrees that it will not directly or indirectly export the Evaluation Board to another country, and that it will comply with all applicable 
United States federal laws and regulations relating to exports. GOVERNING  LAW. This Agreement shall be governed by and construed in accordance with the substantive laws of the Commonwealth of 
Massachusetts (excluding conflict of law rules). Any legal action regarding this Agreement will be heard in the state or federal courts having jurisdiction in Suffolk County, Massachusetts, and Customer hereby 
submits to the personal jurisdiction and venue of such courts. The United Nations Convention on Contracts for the International Sale of Goods shall not apply to this Agreement and is expressly disclaimed. 

©2013–2014 Analog Devices, Inc. All rights reserved. Trademarks and  
 registered trademarks are the property of their respective owners. 
  UG11221-0-9/14(B)  
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